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SAP2000 v25.1.0 Release Notes
© 2023 Computers and Structures, Inc.

Notice Date: 28-November-2023

This document lists changes made to SAP2000 since v25.0.0, released 07-July-2023. Items marked with
an asterisk (*) in the first column are more significant.

Analysis
Enhancements Implemented
* Ticket Description
* 9810 Two enhancements have been made to the handling of time-history, response-spectrum,

steady state, and power spectral density functions: (1.) The addition of new functions and
the modification of existing functions are now allowed after the analysis is run and the
model is locked. Modified functions used by load cases that have already been run will cause
their analysis results to be deleted, along with any design results, with warning and an
option to cancel. (2.) During analysis, only functions that are actually referenced by the load
cases currently selected to run will be processed. For models with very long functions, this
may increase the speed and slightly reduce the memory and storage requirements for
analysis.

9967 An enhancement has been made to automatically detect, report, and utilize all physical
cores for analysis on a system with more than 64 logical processors running Windows 11.
The value will be reported as "Program Determined" for the “Number of (Internal) Threads
for Analysis” option on the "Advanced SAPFire Options" form. Note that the number of
physical cores will typically be half the number of logical processors, though that can vary
from system to system.

* 10139 An enhancement has been made to speed up the analysis when running: (1.) Small- to
medium-sized models using the Standard Solver where the whole stiffness matrix can be
stored in memory as a single block, and (2.) Frequency-domain load cases such as steady-
state, power-spectral-density, and linear frequency-domain time-history analyses.

Database Tables
Enhancements Implemented
* Ticket Description

8064 An enhancement has been implemented to blink the element or object in the graphical
window that corresponds with the selected row within an output table. For windows
displaying objects rather than analysis elements, the parent object will be highlighted, which
may be of a different type than the element results shown in the table. An example of this is
the parent shell object for links created to represent area springs.

9905 An enhancement has been made to display individual table progress in the status bar while
filling any of the “Analysis Results” tables for display/export.

* 9945 An enhancement has been made to significantly speed up display and export of Bridge Load
Definition tables for models with a large number of bridge loads. This includes speeding up
the process of saving the .$BR text file that is automatically written when the model is
saved.

Design – Concrete Frame
Enhancements Implemented
* Ticket Description

9776 An enhancement has been made in IS 456-2000 concrete frame design to include reference
to clause IS 13920:2016 Section 7.1 for the column axial compression limit check for seismic
design in both the right-click design details and the database output table.
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Design – Steel Frame
Enhancements Implemented
* Ticket Description
* 5617 An enhancement has been made to expedite frame member design by parallelizing the

design process. This affects steel, concrete, aluminum and cold-formed steel frame member
designs. Parallelization can be controlled using Analyze menu > Design and Response
Recovery Options > Number of Threads for Design. The Program Determined option is
generally recommended. Setting this value to unity turns parallelization off.

9974 An enhancement has been made to the Eurocode 3-2005 steel frame design to update the
design according to Corrigendum 2 released in 2009. These updates include: The calculation
of npl and Czz in Annex A. Shear area of rolled T-section for load parallel to web in section
6.2.6 (3c). Previously the shear area was calculated as 0.9*(A-b*tf). Cm,z in Table B.3 for the
case Cm,z = 0.9 + 0.1*alpha_h*(1+2*psi). Previously it was Cm,z = 0.9 -
0.1*alpha_h*(1+2*psi). Demand/Capacity ratio calculation according to section 6.2.9.1(6)
for circular hollow section (pipe section). Previously, Equation 6.41 was not included in
calculation of D/C ratio for the pipe. Now, it is calculated for pipe section and the moment
capacity M_N,y,Rd = M_N,z,Rd = Mpl,Rd*(1-n^1.7) is also implemented. Items 3 and 4 have
also been implemented for the Italian NTC 2018 and 2008.

10019 An enhancement has been made for the Eurocode 3-2005 steel frame design to update the
name of the design code to the official name, "EN 1993-1-1:2005/A1:2014." In addition, the
official national annex name is updated. This change is shown in the design preferences, the
design detail report, and design results tables. Any user-developed scripts or other
automated procedures that reference the affected database tables, including tables
accessed through the API, will need to be updated to reference the new table names.

10063 An enhancement was made to speed-up frame design (steel, concrete, aluminum and cold-
formed) when a large number of load combinations were defined and only a few were
selected for design.

10085 An enhancement has been made to the CSA S16-19, CSA S16-14 and CSA S16-09 steel frame
design codes to add the warping torsional constant, Cw, to the design overwrites. The value
can be modified via the overwrites form, database tables, and API functions.

External Import and Export
Enhancements Implemented
* Ticket Description

10087 When importing CIS/2 files, nodes and elements are now imported with the same names as
present in the CIS/2 file. Previously they were simply assigned sequential numbers.

Graphics
Enhancements Implemented
* Ticket Description

9988 A new menu command has been added, Options > Graphics Mode > Video Card(s)
Information, which will display the available video (graphics) cards present on the computer,
along with their GPU memory. The graphics card currently in use by SAP2000 is indicated, as
well as its compatibility for use with DirectX graphics mode in SAP2000. Windows Control
Panel can be used to select a different graphics card for use next time SAP2000 is started.
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Installation and Licensing
Enhancements Implemented
* Ticket Description
* 6953 An enhancement has been implemented to provide a new licensing option, "Cloud Sign-in"

licensing, that utilizes user credentials to access licenses instead of activation keys. This
licensing option can be selected when installing the software, and can be changed later by
running the CSiLicenseAssistant from the Windows Start menu or found in the CSILicensing
subfolder of the SAP2000 installation folder. With this licensing option, user credentials will
be requested when SAP2000 is first started, unless they have already been supplied in an
earlier session of SAP2000 or another CSI software product that uses Cloud Sign-in licensing.
User credentials can be obtained from the customer's IT or other department that manages
software access. Cloud Sign-in licensing requires an active internet connection while running
the software. A commuter-license option is available which allows checking out a license for
a time period up to 30 days, subject to the user's company policy, for use of the software
without an internet connection. Until the commuter license is checked back in or the time
period expires, no other user will have access to that license. Customers can use the CSI
Customer Center to manage which users have access to various CSI products and product
levels through user groups. The CSI Customer Center also provides tools to view license
usage. Access to these features in the CSI Customer Center is subject to permissions set by
the customer's department that manages software access.

* 9793 The version number has been changed to v25.1.0 for a new intermediate release.

Results Display and Output
Enhancements Implemented
* Ticket Description

5945 A change was made to use the same color for hinge acceptance criteria and status in the
material forms, hinge definition forms, screen display, and fiber-hinge results plots. The
colors are editable using the command Options > Graphics Colors > Output.

5989 A change has been made for Section Cuts drawn on screen with 3D views to make the
default location of calculated results be at the center of the elements cut. This can still be
edited by user. Also the screen coordinates of the cut in DirectX graphics mode are now in
model units instead of in screen pixels for easier editing. Note that the screen coordinates
are relative to the projected image, and are different between DirectX and Classical Plus
graphics modes. In Classical Plus, they are measured with respect to the origin of the model,
positive rightward and upward. In DirectX, they are measured with respect to the upper-left
corner of the window, positive rightward and downward. These will be made more
consistent in a future release. Most importantly, the location of the calculated resultant
forces is now consistently based on the elements cut, regardless of graphics mode.

9734 A change has been made to remove the dependency on Internet Explorer for displaying
output (i.e., reports, tables) in HTML format. Now when HTML output is requested it will be
displayed in the default browser on the machine.

* 9886 An enhancement was made to allow the user to disable the saving of individual fiber analysis
results for Fiber P-M2-M3 hinges assigned to frame objects, thereby reducing the amount of
results data that is saved for each step. This option is available in the frame assignment form
(Assign menu > Frame > Hinges) and can be assigned on a per-hinge basis for User Defined
type Hinge Deformation types. When the saving of individual fibers is disabled, the results
for the affected hinges, including state and status, will be available but the option to view
individual fiber results will be disabled in the Hinge Plots form as well as in the "Frame Fiber
Hinge States 02 - Individual Fibers" output table. This option is intended for models with a
large number of fiber P-M2-M3 hinges where the user may not be interested in viewing
detailed fiber results for all hinges.
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* Ticket Description
* 9906 An enhancement has been made to the parallelized design and response-recovery

algorithms to increase the speed and reduce the memory usage and disk IO for models with
large analysis models and/or many long time-history functions. Parallelized response
recovery affects certain larger output tables and time-consuming graphical displays. In
addition, the “Program Determined” values for the number of threads to be used for
parallelized design and response recovery are now set to number of “Performance” cores on
CPUs with hybrid architecture (e.g., Intel 12th generation Core and newer) for better
efficiency over a larger range of models. This is set using command Analyze > Design and
Response Recovery Options.

User Interface
Enhancements Implemented
* Ticket Description

9817 An incident was resolved to show the left and right section-cut results on their respective
left and right sides of the Draw Section Cut form. Previously they were reversed. Results and
the labeling of results were correct, only the locations have been switched.

9966 An enhancement has been implemented to display the object GUID on the right-click object
information form.

10040 A change was made in the Load Case Data form for staged construction to prevent the input
of a Change Section operation on tendons and cables. These operations are not processed
by the analysis and therefore should not be accessible in the user interface.
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Analysis
Incidents Resolved
* Ticket Description
* 10045 An incident was resolved where running one or more nonlinear direct-integration time-

history load cases that started from a non-zero state and also applied displacement loading,
when run in parallel along with other load cases, resulted in a file open error in one or more
of the load cases. When this happened, the results were not available for the affected load
cases. Disabling the “Run Load Cases in Parallel” option avoided this issue.

10198 An incident was resolved where models with panel zone assignments would sometimes give
an error message when the model was run that the panel zone could not be created, after
which the analysis would run but members could be disconnected at the location of the
panel zones. This would happen if the model had frame modifiers and was run more than
once in the same session. Closing the program, then reopening and running the model
would not give the error message and the panel zones would be created correctly.

Data Files
Incidents Resolved
* Ticket Description

9828 An incident was resolved for the import of model text files containing a nonlinear static load
case with results specified to be saved at multiple states. When these were imported, the
values for the min and max number of saved states, as well as the option to save positive
displacement increments only, were always set to default values instead of the values in the
text file. After import the default values would be used for the analysis unless changed by
the user.

9990 An incident was resolved where adding a copy of a load pattern, load case, or load
combination would result in the copied item having the same GUID. There were also missing
GUIDs for certain definition items. These are now being populated in new models. Old
models opened in the new version will have duplicate GUIDs removed and populate missing
GUIDs.

Database Tables
Incidents Resolved
* Ticket Description

9404 An incident was resolved where importing a model with section designer sections with
shapes with a steel material would generate a warning regarding importing the COREDIM
field from the section designer shape tables. This warning did not affect the import, it was
only for information.

Design – Cold Formed Frame
Incidents Resolved
* Ticket Description

9812 An incident was resolved for cold-formed frame design per the AISI-ASD96 and AISI-LRFD96
codes where an abnormal termination could occur during the design of frame members with
I, tee, angle or box sections. Now the design will skip members with one of these sections
assigned, since these are not supported for these older design codes.

Design – Concrete Frame
Incidents Resolved
* Ticket Description

9786 An incident was resolved for the Chinese 2010 concrete frame design code where the MMF
and SMF factors for columns were not matching for the top and bottom columns when all
the column lines did not have the same height. The design has been updated to now
correctly use the factors based on Table 5.3.2.1 (GB 50011-2010 6.2.2, 6.2.5, JGJ 3-2010
3.10.2-2). For SDG = I, the SMFs have been corrected to exclude the factor 1.1.
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* Ticket Description
9980 An incident was resolved for Section Designer (SD) where a concrete tee-shaped section

defined in SD did not have its rebar material correctly assigned and/or saved. This occurred
when the steel tee section was drawn using the SD > Draw Structural Shape > T-Section
toolbar button, and its material was changed to concrete and then reinforcement assigned.
Consequently, the interaction and moment-curvature diagram calculations were incorrect,
affecting the concrete frame design results. However, this did not affect any similarly shaped
section drawn using the Draw Polygon Shape toolbar button. Models from previous versions
will be corrected by assigning the first rebar material found in the material list to any
concrete tee section drawn using the Draw Structural Shape > T-Section toolbar button.

10026 An incident was resolved for the shear design of columns according to the Italian NTC 2008
concrete frame design code in which the alpha_c factor was not correctly determined as
described in Section 3.5.2.2 of the design manual. In particular, for the case where the
column was under tension, alpha_c was previously not taken to be equal to 1.0. For the case
of compressive stress greater than 0.5*fcd, alpha_c was incorrectly calculated to be too
large, resulting in a large overestimate of VRcd. In addition, the optimization of the angle
between the concrete compression struts and the beam axis is now corrected to be
considered for all cases except for beams in Ductility Class High - Moment Resisting Frame.

Design – Concrete Shell
Incidents Resolved
* Ticket Description

10049 An incident has been resolved for the Eurocode 2-2004 concrete shell design in which the
enveloped design results in the data table did not show correctly for the load combos
containing multi-step and double-valued load cases. In particular, the design results were
not retrieved for the governing permutation of the double-valued load before enveloping
over the multi-step load. The contour design results shown on screen using the Display
Design Info command were correct and not affected.

10052 An incident has been resolved for the Eurocode 2-2004 concrete frame design in which the
crack width limit could not be overwritten.

Design – Steel Frame
Incidents Resolved
* Ticket Description

9738 An incident was resolved for the CSA S16-19 and CSA S16-14 steel frame design codes where
the moment ratio was not determined correctly for calculating the unbraced-length limit
according to Section 13.7 for the design of sections in tension. Now the design determines
the two ratios of (1) the major-axis bending moment over the segment braced against
lateral displacement (minor-axis bracing) and (2) twisting (lateral-torsional buckling, LTB
bracing) separately, computes the two laterally unsupported distances (Lcr), and compares
with the corresponding unbraced length of the member to determine whether or not the
unbraced length satisfies the requirement. For the moment diagram being non-linear over
the considered segment, the value of Kappa will be taken as zero.

9759 An incident has been resolved in steel frame design codes "AISC 360-10" and "AISC 360-05,"
in which the D/C ratio is calculated for the double-angle sections using AISC Eqn. H1-1 (H1-
1a or H1-1b, as appropriate) when the major axis bending moment is positive or zero, and
using AISC Eqns. H2-1 when the major axis bending moment is negative. Previously, the D/C
ratio was calculated using AISC Eqns. H2-1 for positive and negative major axis bending
moments.

9827 An incident was resolved for the NTC 2018 steel frame design in which the governing D/C
ratio of the frame changed after the frame connectivity was reversed. This was due to the
tolerance used to determine whether the moment diagram is linear or not when the frame
connectivity is reversed.
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* Ticket Description
* 9893 An incident was resolved in steel frame design where the KL/r calculated for special

concentrically braced frames and ordinary concentrically braced frames were incorrect for
seismic design. The major direction KL/r was being calculated as K_minor*L_major/r_major
and the minor direction KL/r was being calculated as K_major*L_minor/r_minor. In those
cases, K_major and K_minor were switched. The affected codes were AISC 360-16, AISC 360-
10, AISC 360-05, CSA-S16-19, CSA-S16-14, CSA-S16-09, Eurocode 3-2005, Italian NTC 2018,
Italian NTC 2008, Indian IS 800:2007, KBC 2016, and KBC 2009. The use of KL/r for
compression capacity calculations was correct.

9904 An incident was resolved for the CSA S16-19 and CSA S16-14 steel frame design codes where
the seismic design (or check) was not performed for members with framing type LD CBF(V),
LD CBF(TC), LD CBF(OT), LD CBF(TO), MD CBF(V), MD CBF(TC), MD CBF(OT) or MD CBF(TO).
These seismic design checks include axial load, compactness, slenderness, joint design for
doubler plate, panel-zone shear check, and beam/column capacity ratio, connection shear
and/or axial force.

9953 An incident was resolved for the KBC 2009 and KBC 2016 steel frame design codes where the
Analysis Method could not be changed to Effective Length or Limited 1st Order in the design
preferences.

10031 An incident has been resolved for Eurocode 3 and Italian NTC 2008 and 2018 steel frame
designs in which the check for Lambda_bar being less than or equal to 0.2 to ignore global
buckling effects on compression capacity according to Section 6.3.1.2(4) in EN 1993-1-
1:2005 is removed, resulting in a more conservative design.

10051 An incident was resolved for the AISC 360-16 and AISC 360-05 steel frame design codes
where the flexural strength of wide flange sections considering lateral-torsional buckling was
incorrectly calculated. This was due to the torsional constant, J, being taken as zero because
the ratio Iyc/Ix was used instead of Iyc/Iy in the check for being less than or equal to 0.23.

10061 An incident was resolved for the steel frame design codes "Eurocode 3-2005", "Italian NTC
2018", and "Italian NTC 2008" where the section classification of a Class 1 Tee section was
not classified as a Class 1 section when a member was under positive bending moment, and
the web tip was in tension. This error could affect the PMM ratio if the resulting section
classification was different.

Drafting and Editing
Incidents Resolved
* Ticket Description

9309 An incident was resolved where the merging of joints by moving, reshaping, etc., could
result in multiple assignments of a given type being assigned to a joint. This could have
happened with joint restraints, joint constraints, joint panel zones, and joint patterns. The
assignments on the joint could be viewed by right-clicking the joint to display the Joint
Information form listing the assignments. Typically the last assignment of a given type to the
joint would govern except for the restraints. The restraints were being merged for analysis.
Older models, when opened in the new version, will have the multiple assignments
removed, keeping only the last assignment of each type except for restraints where the
assignments are merged. Analysis results should not be affected.

9972 An incident was resolved where drawing of special joints in elevation view was not creating
the joints at the expected location.

External Import and Export
Incidents Resolved
* Ticket Description

9788 An incident was resolved where the export to DXF would fail if shell contours were
requested in the export options and the current model window was not displaying shell
contours. Now the export will continue in this case, but no contours will be exported.
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* Ticket Description
10072 An incident was resolved affecting the import of CIS/2 files where the shape, dimensions,

and properties of steel sections defined by reference to a catalog name were not imported.
Instead these sections were imported with a default shape and default dimensions and
properties, with warnings alerting the user of the issue. This incident affected SAP2000
v23.3.0 and later.

10089 An incident was resolved where SAP2000 did not import CIS/2 files with measures in units
that had prefixes other than milli, centi, kilo, or mega. For example, SAP2000 could not
import a CIS/2 file in which masses were measured in decigrams. When this occurred the
error was obvious: an error message was displayed and no model was created. The full
range of CIS/2 unit prefixes, from 'atto' to 'tera', is now supported.

Graphics
Incidents Resolved
* Ticket Description

7404 An incident was resolved where the contours displayed to represent shell stresses and
strains were not always correct in DirectX graphics mode when the option "Visible Face" was
selected and the model was rotated in a 3D view. The contours were correct for the visible
face when the contours were first drawn, but the results for the same face continued to be
shown even if the model was rotated so that the opposite face became visible. This issue did
not affect Standard (GDI Plus) graphics mode.

9370 An incident was resolved where the contour display of uniform to frame area loading in the
gravity direction was displaying contours of opposite sign. This was a load display issue only.
The loading was applied in the correct direction for analysis.

9716 An incident was resolved where the extruded display of frame objects could be incorrect if
the frame section property was nonprismatic and one or more of the frame-section
properties included in the nonprismatic definition were of Section Design (SD) type. If the
origin (x,y) of one of the SD sections was not at the centroid of that SD section, then the
extruded view of nonprismatic section would be incorrect in terms of the insertion point at
the affected SD section. This was a graphical display issue only and did not affect analysis or
design results. Note that the extruded view of an SD section in a nonprismatic member is
displayed as a rectangle representing its bounding box.

9848 An incident was resolved for DirectX graphics mode where the orientation of the X and Y
axes would sometimes rotate from the specified Plan Angle when the 3D view was set to be
from above (Elevation Angle 90) and the Aperture Angle was zero. The Plan Angle would
sometimes rotate when deleting objects or limiting the view to selected objects.

Loading
Incidents Resolved
* Ticket Description

9914 An incident was resolved where defining an ASCE 7-22 auto wind load for open frames was
causing an abnormal termination if the "Solid / Gross Area Ratio" was specified in the form.

* 10094 An incident was resolved where an acceleration loading applied to a multi-stepped load case
at a given starting load case step that was greater than 1 was ignored if the total number of
load case steps (due to other applied loading) was less than the given starting load case step
for the acceleration loading. For example, if the acceleration was specified to start at load
step 3 and any other applied load patterns only loaded steps 1 and 2, then the acceleration
loading was not applied. This was not a common case.

10106 An incident was resolved for the ASCE 7-22 auto-wind load pattern where the directional
factor (kd) was applied twice. This caused an unconservative wind load when kd was less
than unity.
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Results Display and Output
Incidents Resolved
* Ticket Description

2236 An incident was resolved where the Capacity Spectrum conversion of the Pushover curve
based on ATC-40 or the FEMA 440 Equivalent Linearization method was not correct for
loadings not in the X or Y planes.

9683 An incident was resolved where the Selection List form would keep opening up when
moving the mouse over solid elements that were displaying stress contours in DirectX
graphics mode. This made it impractical to see the stress values that should be shown at the
location of the mouse cursor. This issue did not affect GDI Plus (standard) graphics mode.

9824 An enhancement has been implemented to allow users to specify different diagram fill
colors for range-positive and range-negative values when plotting frame forces/stresses for
multi-valued load cases and combinations. Previously, the same fill color was used for both
positive and negative enveloped values.

9915 An incident was resolved where the soil pressure contours were not displayed in a window if
the window had previously been displaying principal shell results with arrows. This was a
display issue only and did not affect the results.

9947 An incident was resolved where the Internal Hysteretic Damping energy for Link objects with
a MultiLinear Elastic type property was incorrectly reported as non-zero values for nonlinear
load cases. This was an energy-reporting issue only and did not affect any other results.

9971 An incident was resolved where the Steel Design 2 - PMM Details - Italian NTC 2018 table
was not included in the report. The name of this table was changed to Steel Design 2 - NMM
Details - Italian NTC 2018 in v24.0.0, but the CSiDefaultReportContents.xsd schema file was
not updated and therefore the report would generate without displaying any errors as to
why the table was missing. Now the schema file has been updated and will generate an
error that the table key is not valid. The user must modify any report contents XML files and
update the table key(s) that are in error.

Section Designer
Incidents Resolved
* Ticket Description

10021 An incident was resolved in section designer where importing DXF data using a length unit
different from the model database units would result in the imported numerical values not
being correctly scaled. The imported values were visible in section designer and analysis
results were based on those values.

Structural Model
Incidents Resolved
* Ticket Description
* 10062 An incident was resolved where hinges were not created for analysis in frame objects

assigned with a "Continuous Spring Support" hinge-distribution type (Assign menu > Frame >
Hinges) in a model where the Analysis Model for Nonlinear Hinges (Analyze menu > Analysis
Model for Nonlinear Hinges) was set to "Model Hinges as Separate Link Elements."

User Interface
Incidents Resolved
* Ticket Description
* 9858 An incident was resolved where the software could terminate abnormally when adding,

copying, or deleting a definition via a form that had a list or dropdown list of the items and
there were more than 32,767 items in the list. This was a user-interface issue only and did
not affect results.
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* Ticket Description
10001 An incident was resolved to correct following issues with the model explorer 1) The Function

node of the model explorer was not getting populated when a new model was created or a
model with function definitions was opened. 2) With the Model Alive feature active, an
analysis run was not getting triggered when the load case definitions were modified or new
load cases were added through model explorer. 3) The load case node, when in expanded
state, was not getting updated upon importing a model in various formats with the option to
add to the existing model. Several other nodes had the same issue which has now been
fixed. 4) Hinge Property node of the model explorer was not being updated when hinge
assignments were made to frames or existing frame hinge assignments were deleted.

10093 An incident was resolved where ASCE 41-17 auto-hinges may be listed with an incorrect or
no degree-of-freedom text when displaying hinge assignments in the model window, in the
right-click properties form, on the Hinge Results form (Display menu > Show Hinge Results),
and in the Frame Hinge Assignment database tables. This was a display issue and did not
affect results. The ASCE41-17 hinge used for analysis was consistent with the auto hinge
definition and the generated hinge property (Define menu > Section properties > Hinge
properties).


